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1Introduction 1 

Introduction 1.1

Preparation Gilson with SampleTrack (PrepGilsonST) is a sample preparation
program which controls a Gilson "215" or "235" instrument with additional "8xx"
valves and "ValveMate".

Predefined preparation step procedures can be modified by the user and will be
executed.

Depending on the application type, a barcode reader identification can be used
and orders can be defined by the "SampleTrack" program.

The type of destination racks can be specified and used to define destination po-
sitions automatically.

When SampleTrack is not used, the user can create orders when defining source
samples, procedures, and push solvents.

Note: Throughout this manual Preparation Gilson with SampleTrack will simply be
referred to as PrepGilsonST.

How to Request Support 1.2

For further information or technical support please contact the author at:

martin.beck@bruker-biospin.de
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2Menus 2 

File Menu 2.1

The File menu offers the following commands: 

Open Current Session
Use this command to open the current session file (curr_session.pgi) after
checking an old session file. 

The current session file is loaded automatically when the program is
opened.

Shortcut Keys: CTRL+O

Open Old Session
Use this command to open an old session file (*.pgi) in the PrepGilsonST
program.

Save ... As
Saves the current session file as a different file name.

Use this command to save the active session as a file with another name
(only used for checking the settings at later time!).

PrepGilsonST displays the Save As dialog box so you can save the file un-
der a specific file name. The Save As dialog box offers the following options
which allow you to specify the name and location of the file you're about to
save:

File Name: Used to save a document under a new file name. Type in the
new name in this field. The program adds the extension you specify in the
Save File As Type box.

Drives: Used to select the drive where you want to save the document.

Directories: Used to select the directory where you want to save the docu-
ment.

Table 2.1. The File Menu Commands

Open Current Session Opens the current session file curr_session.pgi.

Open Old Session Opens an old session file .pgi

Save As Saves the current session file as a different file name.

Save Current Log Files Saves the current protocol files.

Exit Exits the PrepGilsonST program.
User Guide Version 001 7 (59)



Menus
Network: This button is used to connect to a network location, assigning it
a new drive letter. 

Save current ... log files
Saves the current protocol files. During this procedure a copy of the current 
protocol files are produced as follows:

log_current.log saved to ...\G215Data\Exec\saved_log_current.log
log_exec.log saved to ...\G215Data\Exec\saved_log_exec.log

A copy of the session file is also made:

curr_session.pgi saved to ...\G215Data\Exec\saved_curr_session.pgi

Exit
Exits the PrepGilsonST program. 

Use this command to end your „PrepGilsonST“ session. You can also use
the Close command on the application control menu. The program will
prompt you to save documents with any unsaved changes if applicable.

Shortcuts: 

Mouse: Double-click the application's Control menu button.

Keys: ALT+F4

Edit Settings Menu 2.2

The Edit Settings menu opens the Edit Settings dialog where the following
preparation modes can be defined.

Edit Setting Dialog: SampleTrack 2.2.1

Enable SampleTrack 
If checked, the orders are retrieved from the directory SampleTrack Order Direc-
tory + \in\

If unchecked, the orders are retrieved from the directory SampleTrack Order Di-
rectory + \in_no_ST\

Procedure Export Directory 
All Procedures in this directory will be written into the file procedures.txt at initial-
ization time.
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Edit Settings Menu
The file procedures.txt is also placed into the directory SampleTrack Order Di-
rectory.

Edit Setting Dialog: Preparation Mode 2.2.2

Using Destination Matrix
If checked, the field Destination Matrix Type is used to find an empty destination
matrix of this type for orders loaded in the currently inserted source racks.

Check if Destination Tubes Empty
If checked, the program queries SampleTrack and creates an error message if the
position in the destination matrix is not empty. 

This option is automatically checked if the option Enable SampleTrack is
checked.

Verify each Procedure Only One Time
Procedures with the same name will be checked only one time before execution.

Edit Setting Dialog: Automatic Clean Procedure 2.2.3

The Clean Procedure name is defined in the   "Configuration" section (see also
"Clean Procedures Menu").

Select the appropriate options to run this procedure before the beginning of the
order procedure loop or/and after the last order.

The Volume, Speed and Wait values will be used in the clean procedure.
User Guide Version 001 9 (59)



Menus
Figure 2.1. The Edit Settings Window 

Preparation Menu 2.3

The Preparation menu offers the following commands: 

Start Preparation Automation
Command: Start All

Starting automation - A new preparation loop for all available orders will be start-
ed:

Table 2.2. The Preparation Menu Commands

Start Preparation Automation Start Automation = Init + Read Barcodes + Read 
Orders + Verify + Preparation

Pause after current movement Preparation Pause: Stop after current movement and 
wait. Select the menu Continue to continue the prep-
aration.

Continue Continue the preparation after Pause.

End after current order Stop after the current order and finish order loop.

Abort current order Abort the current order and finish order loop.

Move arm to other side Moves the Gilson arm into a different position if the 
barcode reader did not allow the rack exchange.
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Preparation Menu
• Initialize Gilson

• Read Barcodes

• Load Orders 

• Verify Orders

• Run default Clean procedure if selected in the settings dialog

• Run Preparation procedures loop (for all available orders) 

• Run default Clean procedure if selected in the settings dialog

Select the menu "Pause After Current Movement" or the toolbar  to stop
the preparation.

Select the menu "End After Current Order" or the toolbar  to stop after cur-
rent order and to finish the order loop.

Select the menu "Abort Current Order" or the toolbar  to abort the prepara-
tion immediately.

Shortcuts: Toolbar  Keys:CTRL+A

Pause After Current Movement
Preparation pause: Stops after current movement and waits for menu "Contin-
ue".

Select the menu "Continue" or the toolbar  to continue the preparation

Continue
Select this menu to continue the preparation after Pause.

Shortcuts: Toolbar 

End After Current Order
Stops after the currently running order and finishes the order loop.

Shortcuts: Toolbar 

Abort Current Order
1. The currently running order will be stopped immediately with an error status.

2. If the order loop was running it will be stopped. 

3. A Home Seek will be performed automatically.

Shortcuts: Toolbar 

Move Arm to Other Side
Moves the Gilson arm into a different position if the barcode reader did not allow
the rack exchange.

Shortcuts: Toolbar 
User Guide Version 001 11 (59)
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Service Tools Menu 2.4

The Service Tools menu offers the following commands: 

Initialize Gilson 
Runs the Initialize Gilson task. 

1. Writes a procedure list file of all usable procedures in SampleTrack.

2. Writes a solvent list file of all defined solvents for SampleTrack.

3. Starts to write a new current protocol file.

4. Resets errors.

5. Sets Gilson Z-tower clamp height variable.

6. Sets Gilson liquid level detection threshold variable.

7. Initializes barcode reader (if installed).

8. Checks Z-axis.

9. Checks XY-axis.

10. Checks Dilutor pump.

Initialize Pump
Initializes the Gilson instrument and the Dilutor pump.

Table 2.3. The Preparation Menu Commands

Initialize Gilson Initialize the Gilson instrument.

Initialize Pump Initialize the Gilson instrument and the Dilutor pump.

Initialize + Home Initialize the Gilson instrument and perform a home seek.

Read Barcodes Runs the Read Barcodes task.

Load Orders and Verify Load Orders from order directory and Verify orders.

Prepare Orders Prepare the orders.

Modify Procedure Shows or hides a Procedure View in the main window in 
order to modify task procedures at a high edit level for cus-
tomers.

Set Procedure/Config in Registry Set Procedure and Configuration in the registry

Preparation of Orders on other Instru-
ment

Enable Preparation of Orders on another instrument: 
Copy oOrders back from ...\in\exec \

Create Test Orders Dialog Create Test Orders dialog.

Delete Map: Source-Destination Matrix Delete Map: Source destination matrix

Reload Config File Reloads configuration file.

Test Test: Copy orders back from ...\in\save\
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Service Tools Menu
Initialize + Home Gilson
Runs the Initialize + Home Gilson task. 

1. Writes procedure list file of all usable procedures in SampleTrack.

2. Writes solvent list file of all defined solvents for SampleTrack.

3. Start to write a new Current protocol file.

4. Reset errors.

5. Set Gilson Z-tower clamp height variable.

6. Set Gilson liquid level detection threshold variable.

7. Initialize barcode reader (if installed).

8. Homing Z-axis.

9. Homing XY-axis.

10. Homing Dilutor pump at rinse station.

Read Barcodes
Runs the Read Barcodes task. 

1. Reads both ID and TYPE barcodes at all defined barcode racks (displayed
with red frames in the Barcode view of the Tray Configuration).

2. Deletes old Barcode defined racks in the tray configuration if they are removed
from the Gilson.

3. Creates new barcode defined racks and zones (with the name of the Rack ID
barcode) in the tray configuration if the barcodes are found.

All sites in the Tray "Configuration" can be defined as barcode defined sites with
a default rack type. The default rack type is used to define the XYZ positions of
the ID and TYPE barcodes on the rack.
User Guide Version 001 13 (59)



Menus
Figure 2.2. Working Area Configuration: Barcode Zones 

Load Orders and Verify
Runs the Load Orders and Verify task (without Automation after Initialize and
Read Barcodes).

Prepare Orders
Runs the procedures preparation loop (for all available orders without Automa-
tion after Initialize, Read Barcodes, and Load Orders and Verify).

Modify Procedure
Modifies the current procedure in the registry and saves as a different procedure
(the next free extension „_1”, „_2”, „_9” will be automatically added to the source
file name).

To change the source procedure, use the Service Tools menu "Set Procedure
and Config File in Registry".

Modification of the current procedure works only with „TASK” procedures, a spe-
cial type of procedures with a customer dialog to change parameters. 

After modification of the task values in the dialog, the procedure will be saved un-
der a different file name!

If the current procedure in the registry is not a TASK procedure the following mes-
sage appears:

„Procedure is not a TASK procedure! ”

The source procedure can be changed by using the menu "Set Procedure and
Config File in Registry".
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Service Tools Menu
Figure 2.3. Two examples of TASK procedures 

Set Procedure and Config File in Registry
The following dialog of the GExec control will be opened:

Figure 2.4. Set Procedure and Configuration in Registry 
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Menus
Pressing OK will write the path and file names into the registry keys: 

Procedure file: Bruker BioSpin    Gilson Control    EditProcedure    Procedure

Config file: Bruker BioSpin    Gilson Control    GexecCtrl    Config file

Data Path: Bruker BioSpin    Gilson Control    DataPath

The Procedure file name is used when opening the "Modify Procedure". 

- Dialog menu. 

Preparation of Orders on another Instrument
Enables preparation of orders on another Instrument:

Copies orders back from the directory ...\in\exec\  into the directory ...\in\

Create Test Orders Dialog
Opens the Create Test Orders Dialog window. 

Figure 2.5. Create Test Order Files 
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Clean Procedures Menu
Delete Map: Source/Destination Matrix
Deletes all relations between the source Matrix ID Racks and Destination Matrix
ID Racks.

Only relevant with option „Preparation Mode: Using Destination Matrix” in the
"Edit Settings Menu" dialog!

After reading the Rack ID barcodes during the „Loading and Verifying Orders”
procedure, all orders will be checked if they need a new Destination Rack of the
Destination Rack Type, as defined in the field „Destination Matrix Type” of the
"Edit Settings Menu" dialog.

If there is no Destination Rack defined for the current Source Rack in the Source/
Destination Map, and an empty Destination Rack is found in the tray, then the cur-
rent Source Rack of the Order and the empty Destination Rack will be written as
“connected” into the Source/Destination Map. 

The Source/Destination Map will then be saved.

After restarting the program, or for new Source Rack orders in the Source/Desti-
nation Map, the Destination Rack will be the same.

If a Barcode ID is used more than one time (not recommended!):

• The customer must clear the Destination Rack and fill the Source Rack.

• If only the Source or the Destination ID has changed, this menu has to be used
to delete all Relations between Source Matrix ID Racks and Destination Matrix
ID Racks.

Reload Config File
Reloads the configuration file after modifications. 

Copy Orders back from ...\in\save\
Copies orders back from the directory ...\in\save\   into the directory ...\in\

Used for tests or if racks with the same Barcode ID when the same samples are
reused.

Clean Procedures Menu 2.5

The Clean Procedures menu offers the following commands, which enable you
to arrange multiple views of multiple documents in the application window:

Table 2.4. The Preparation Menu Commands

Clean Needle Runs the Clean Needle procedure.

Prime Dilutor Runs the Prime Dilutor procedure.

Prime Inject Port Runs the Prime Inject Port procedure.

Set ValveMate default solvent 
position

Moves ValveMate to the default solvent 
position (defined in the Dilutor configura-
tion).
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Menus
The procedures Clean Needle, Prime Dilutor and Prime Inject Port are defined in
the configuration:

Figure 2.6. Configuration Gilson 215 

Clean Needle menu command
Runs the Clean Needle procedure. 

The procedure name is defined in the Gilson Liquid Handler 215 section of the
configuration.

Prime Dilutor menu command
Runs the Prime Dilutor procedure. 

The procedure name is defined in the Gilson Liquid Handler 215 section of the
configuration.

Prime Inject Port menu command
Runs the Prime Inject Port procedure. 

The procedure name is defined in the Gilson Liquid Handler 215 section of the
configuration.

See also: "Configuration"
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View Menu
View Menu 2.6

The View menu offers the following commands: 

Toolbar command (View menu)
Use this command to display and hide the toolbar, which includes buttons for
some of the most common commands in PrepGilsonST, such as File Open. A
checkmark appears next to the menu item when the toolbar is displayed.

See "Toolbar command (View menu)" for help on using the toolbar.

Status Bar command (View menu)
Use this command to display and hide the Status Bar, which describes the action
to be executed by the selected menu item or depressed toolbar button, and the
keyboard latch state. A checkmark appears next to the menu item when the status
bar is displayed.

See "Status Bar command (View menu)" for help on using the status bar.

Show or hide the Barcode List
Shows or hides the barcode list dialog view.

Table 2.5. The View Menu Commands

Toolbar Shows or hides the toolbar.

Status Bar Shows or hides the status bar.

Barcode List Shows or hides the barcode list of connected source 
and destination barcode racks.

Modify Procedure Shows or hides a Procedure View in the main window 
to modify Task procedures at a high edit level for cus-
tomers.

Configuration Shows or hides the configuration dialog view.

Tray Shows or hides the tray dialog view.

Main Log File Shows or hides the main protocol in the protocol dia-
log view.

Log File Shows or hides the current protocol in the protocol 
dialog view.

Procedure Steps Shows or hides the current master step procedure dia-
log view.
User Guide Version 001 19 (59)



Menus
Figure 2.7. Barcode List Dialog 

Shortcuts: Toolbar 

View Menu Modify Procedure
See "Modify Procedure"

Configuration 
See all view menu commands: "View Menu"

Shows the Configuration View to see configuration details or to perform modifi-
cations.

Each of the different configuration sections are displayed inside a blue frame:

• Liquid Handler System: Defines the basic configuration.

• Gilson Liquid Handler 215: Defines default files and Gilson instrument type
specific configuration.

• Gilson Cover + LED configuration: Defines the reaction after opening the cov-
er.

• Dilutor: Defines the usable solvent list, the Dilutor syringes and default solvent.

• Valvemate: Defines the Valvemate solvents.

• Working area: Defines the working area (trays, solvents, barcode defined
racks).

• Z-tower: Defines the needle adjustment.

• Valves configuration: Valves and capillary configuration.

• NMR probe head: Sample configuration.

Move the mouse cursor inside the blue frames to show tool tips in the configura-
tion section!

Click inside the blue frames to open the dialog box of the configuration section!
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View Menu
Figure 2.8. The Configuration Dialog Window 

Shortcuts: Toolbar 

Tray View
See all View Menu commands: "View Menu"

Shows the Tray View.

Figure 2.9. The Tray View Dialog Window 

Shortcuts: Toolbar 

Main protocol file
See all view menu commands: "View Menu"

Shows or hides the main protocol file.
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Menus
Figure 2.10. Main Protocol File 

See also: View Protocol Files below.

View Protocol files
See all View Menu commands: "View Menu"

Shows or hides the Protocol View.

Different information can be displayed in the protocol view:

1. Input order files from SampleTrack.

2. Output result order files to SampleTrack.

3. Current procedure protocol file.

4. Procedure protocol file of a finished order.

5. Current main protocol file.
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View Menu
Figure 2.11. Example of a Protocol File View 

Shortcuts: Toolbar 

Procedure Step View
See all View Menu commands: "View Menu"

Shows the Procedure Step View:

• Move the mouse cursor over one step, or click on the step icon to see details
of one step!

• Shows the currently loaded or running main procedure in the upper part of the
window

• If there is a sub-procedure running, it is shown in the lower part of the window.

Figure 2.12. Procedure Step View 

Note: 

• It is not possible to display the procedure as a text file, but only as a protocol
text file after execution.
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Menus
• For service personal only: Procedures that are not running can be displayed
in the Procedure Editor program

Shortcuts: Toolbar 

Help Menu 2.7

The Help Menu offers the following commands, which provide you assistance
with this application: 

Index command (Help menu)
Use this command to display the opening help window. From this window, you
can jump to step-by-step instructions on using PrepGilsonST and various other
types of reference information. 

Once you open the help window you can click the Contents button whenever you
want to return to the opening screen.

About command (Help menu)
Use this command to display the copyright notice and version number of your
copy of PrepGilsonST.

Table 2.6. The Preparation Menu Commands

Help Topics Offers you an index of topics on which you can get help.

About Displays the version number of this application
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3Start Selections 3 

Defining Procedure Type 3.1

When starting the program the first time after installation the "Default Procedure
Selection" dialog appears enabling you to define the type of procedure and con-
figuration settings in the registry.

Four types of procedures can be selected:

• Urine

• 1mm sample

• BEST

• Custom ICL

The procedures can be exported and are shown in the SampleTrack selection box
after performing an initialization using menu “Service tools” -> "Initialize Gilson".

When you select the checkbox „Do not show this dialog again“ in this dialog, or in
the "Edit Settings Menu" window, this dialog will not be visible when restarting
the program.

Default Procedure Selection 3.1.1

When starting the program the Default Procedure Selection box appears which
alls you to define default settings in the registry, or can modify the path inside all
the procedures after installing this program:

Figure 3.1. The Select Default Procedure and Configuration Window 
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Start Selections
The following files will be set in the registry:

1. Urine preparation

GExecCtrlConfig file= \Config\Urine.cfg\
EditProcedure Procedure=\Proc\Custom\default_Urine.gsp\

2. 1mm Sample preparation

GExecCtrlConfig file= \Config\default_1mm.cfg
EditProcedure Procedure= \Proc\1mm\default_1mm.gsp

3. BEST preparation

GExecCtrlConfig file= \Config\default_BEST.cfg
EditProcedure Procedure= \Proc\BEST\default_BEST.gsp

4. Custom ICL preparation

GExecCtrlConfig file= \Config\_Cfg_Imp_College.cfg
EditProcedure Procedure= \Proc\BEST\Test Frame Urine Proc.gsp

The following „Current session” default files will be copied into the file\ex-
ec\curr_session.pgi:

1. Urine preparation: default_session_Urine.pgi

2. 1mm Sample preparation: default_session_1mm.pgi

3. BEST preparation: default_session_BEST.pgi

4. Custom ICL preparation: default_session_ICL.pgi

If it is desired that this box does not appear the next time the program is started,
please select:

• The checkbox „Do not show this Dialog again!” in this dialog, or, 

• The checkbox „Do not show the Default Selection Dialog when starting the
program!” in the "Edit Settings Menu" dialog.

Starting the BEST Sharing Mode 3.1.2

Define procedure type „BEST“ in the "Default Procedure Selection" window
when starting the program. 

The files „default_BEST.cfg“ and „default_BEST.735“ are special configuration
files for BEST and will be cross-checked and overwritten automatically when im-
porting the current configuration from BEST.
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Defining Procedure Type
Check registry entry „BEST host name“ (BEST directory with file
„BEST_config.txt“ must be exported): 

The text file „Procedures.txt“ in the directory „...\bstsdata\spect\prep\“ on the
BEST host contains the exported procedures.

All the exported procedures must be located in the export directory, which can be
defined in the "Edit Settings Menu" dialog (default directory:
„…\G215Data\Proc\BEST\“).

The file „Procedures.txt“ is written when this program is started and connecting to
BEST (connecting to BEST only if no direct RS232 connection to a Gilson 215
found).

The value of variable "NUMBER_OF_DIFF_DEST" defines the number of differ-
ent destination positions in the procedure.

In the text file „Procedures.txt“, one line defines one procedure (the „Space“ or
„Tab“ can be used as delimiter’s between the procedure name and the procedure
type in one line). 

For example:

Test_BEST.gsp new

Test_BEST_S.gsp same

• Type „same“: The source position (defined by the variables ORGMATRIXID
and ORGMATRIXFIELDPOSITION in the order file) and destination position of
the preparation are the same. 

• Type „new“: The source and destination position of the preparation are differ-
ent: The variables MATRIXID and MATRIXFIELDPOSITION in the order file
are necessary to define a different destination position of the preparation.

Start first the BEST program: XWIN-NMR 3.1 Windows ICON-NMR.

Automation Admin User ID: Guest OK   Password: “” + Enter

(This program writes the file „BEST_config.txt“ and defines the sharing mode with
the variable ##$SHAREMODE=1).

When starting the PrepGilsonST.exe program the Gilson 215 instrument must be
initialized beforehand!

Status bitmap, if in sharing mode OK: 

Other modes: Direct connection:  Gilson link mode: 
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4Preparation Data 
Files 4 

Data Directory Structure 4.1

Structure:

[Install Dir]\G215Data\

\Config\

\Prep\

\Custom\

\1mm\

\BEST\

\ICL\

\Temp Test\ temporary directory for service test files 

\Test\ for release test files 

\Exec\

Main Directory:

[Install Dir]\G215Data\(defined when installing the program)

Configuration Files Directory: 

[Install Dir]\G215Data\Config\

1. All data in the current configuration (file extension: *.cfg), including the tray file
name, e.g. Current_Config_data.cfg.

2. Data in the current tray (file extension: *.735), including the tray geometry da-
tabase file name, e.g.: Current_Tray_Config.735.

3. Data of tray geometry database (file extension: *.geo). This file is used when
inserting racks (e.g. after barcode reading). e.g.: GRack_data_all.geo.

Preparation Procedure Files Directory: 

[Install Dir]\G215Data\Prep\

1. Common procedure files used by most users (file extension: *.gsp or *.gfp).
e.g.: Prime_only.gsp.

[Install Dir]\G215Data\Prep\TypeOfProcX\
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1. Procedure files specific for one type of procedure (file extension: *.gsp or
*.gfp) e.g.: ICL Urine prep 0401.gsp.

Temporary Settings Files:

[Install Dir]\G215Data\Exec\

1. Session files with saved settings (from Settings Dialog - file extension: *.pgi).

2. Saved Session file after an error or Menu Save current ... log files.

3. Current preparation status file (file extension: *.sts  - currently not used).

Temporary Protocol Files: (see also "View Protocol files" on page 22).

[Install Dir]\G215Data\Exec\

1. Current main protocol file of the current session (log_exec.log).

2. Current protocol file of the running procedure (log_current.log).

3. Saved protocol files (saved_log_exec.log and saved_log_current.log) after an
error occurs or after saving the file with „menu save current ... log files“.

After completion of the SampleTrack order procedure the current protocol file, [In-
stall Dir]\G215Data\Exec\log_current.log, will be renamed (to the order name)
and saved in the SampleTrack order files directory:

C:\bstsdata\gilson\out...\protocol\ 

(See the SampleTrack order files directory structure).

Viewing Data Files 4.2

The currently running procedure is shown in the Step View.

To find the file directory see the "Data Directory Structure" on page 29.

Protocol Files 4.3

Current Preparation Protocol File Directory:  (see also: "View Protocol files"
on page 22).

[Install Dir]\G215Data\Exec\

Current main procedure protocol file: log_exec.log

Current protocol file of running procedure: log_current.log

After an error or Menu Save current ... log files a copy of the current protocol files
will be performed:

log_current.logto ...\G215Data\Exec\saved_log_current.log
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log_exec.logto ...\G215Data\Exec\saved_log_exec.log

After completion of the SampleTrack order procedure the current protocol file, [In-
stall Dir]\G215Data\Exec\log_current.log, will be renamed (to the order name)
and saved in the SampleTrack order files directory: 

C:\bstsdata\gilson\out...\protocol\ 

(See the "Data Directory Structure" on page 29)

Directory of saved protocol files after execution of SampleTrack orders: 

C:\bstsdata\gilson\out\protocol\ (when running with SampleTrack)

C:\bstsdata\gilson\out_no_ST\protocol\ (when running without SampleTrack -
e.g. BAY000100  NMR  31.log

(See the "SampleTrack Order Directory Structure:" on page 33).
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5SampleTrack Order 
Files 5 

Order Directory Structure 5.1

Note: To allow access to old order information, old files will not be automatically
deleted!

The user should delete all old orders in the following subdirectories!

SampleTrack Order Directory Structure:
C:\bstsdata\gilson\

\in\

\in\exec\

\in\save\

\in\error\

\out\

\out\save\

\out\error\

\out\protocol\

\in_no_ST\

\out_no_ST\

Main Directory:
C:\bstsdata\gilson\ (defined by SampleTrack)

Input Order Files Directory (to carry out): 
C:\bstsdata\gilson\in\ (when running with SampleTrack).

C:\bstsdata\gilson\in_no_ST\ (when running without SampleTrack).

Contains all order files (file extension: *.p) to carry out.

When after verification the status is OK, the files will be moved into the directory
\in...\exec\. If an error occurs the files will be moved into the directory \in...\error\.

After execution of the order the files will be moved into the directory \in...\save\.
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Output Order files directory (results after execution): 
C:\bstsdata\gilson\out\ (when running with SampleTrack).

C:\bstsdata\gilson\out_no_ST\ (when running without SampleTrack).

Contains all order files with results after execution (file extension: .r).

After result handling by the SampleTrack Communicator, the files will be moved
into the directory \out\save\ if status OK or into the directory \out\error\ if an error
occurs. 

Order Protocol files directory (after running the order procedure): 

C:\bstsdata\gilson\out\protocol\ (when running with SampleTrack).

C:\bstsdata\gilson\out_no_ST\protocol\(when running without SampleTrack).

After completion of the SampleTrack Order procedure, the current protocol file
[Install Dir]\G215Data\Exec\log_current.log will be renamed (to the order
name) and saved in the SampleTrack order files directory: 

C:\bstsdata\gilson\out...\protocol\ 

(See also "Data Directory Structure" on page 29).

Viewing Order Files 5.2

To view the JCAMP SampleTrack order files:

1. Right click on the order in the order list and select Show input: order from
SampleTrack to see the order from within SampleTrack.

2. Right click on the order in the order list and select Show output: report to
SampleTrack to send the report to SampleTrack.

To view the protocol files:

1. Double click on the order in the order list!

To find the file directory reference to SampleTrack see "Order Directory Struc-
ture" on page 33.

See also: "Viewing Data Files" on page 30.

Protocol Files 5.3

Current Preparation protocol file directory: [Install Dir]\G215Data\Exec\(see
also: "View Protocol files" on page 22)

Current main procedure protocol file: log_exec.log
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Current protocol file of running procedure: log_current.log

After an error or „Menu Save current ... log files“, a copy of the current protocol
files will be copied from:

log_current.log to ...\G215Data\Exec\saved_log_current.log

log_exec.log to ...\G215Data\Exec\saved_log_exec.log

After completion of the SampleTrack order procedure the current protocol file, [In-
stall Dir]\G215Data\Exec\log_current.log, will be renamed (to the order name)
and saved in the SampleTrack order files directory:

C:\bstsdata\gilson\out...\protocol\ 

(See the "Data Directory Structure" on page 29)

Directory of saved protocol files after execution of SampleTrack orders: 

C:\bstsdata\gilson\out\protocol\ (when running with SampleTrack)

C:\bstsdata\gilson\out_no_ST\protocol\ (when running without SampleTrack)

e.g. BAY000100 NMR 31.log

(See the SampleTrack"Order Directory Structure" on page 33).
User Guide Version 001 35 (59)



SampleTrack Order Files
36 (59) User Guide Version 001



6Solvents 6 

Defining Solvents 6.1

1. External NMR Solvents:
The external NMR solvents are defined in a text file (e.g.: solvents.txt).

The name of his text file can be defined in the configuration dialog window (see
"Configuration" on page 20) or by clicking on the Gilson liquid handler 215 (de-
fault files, ...) to open the configuration Gilson 215 Dialog window.

Figure 6.1. External NMR Solvent Configuration

In the property sheet Default Files, the default file name and directory of the type
External NMR solvent file can be changed to define the ambient solvent file
used.

The External NMR Solvents are used inside the Dilutor Configuration dialog to
define the preparation solvents used.

2. Used Preparation solvents:
To edit the solvents used for preparation, open the configuration dialog window
(see "Configuration" on page 20) and click on the Dilutor (dilutor syringe) to
open the Dilutor configuration dialog:

• All defined external NMR solvents can be used.

• Additional solvents only for the preparation can be defined.
User Guide Version 001 37 (59)



Solvents
To define the solvent positions in the Gilson instrument for preparation open the
configuration dialog window (see "Configuration" on page 20) and click on the
place where you want to use the solvent:

• Dilutor (dilutor syringe): opens the Dilutor Configuration Dialog.

• Valvemate: Opens the Valvemate Configuration Dialog

• Working area: Opens the working area (trays, solvents, …) configuration dia-
log. In the property sheet solvents is the default.

To view or edit the configuration see: "Configuration" on page 20.
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Modifying Task Procedures 7.1

If the source TASK procedure is selected in the registry, then you must:

1. Modify the procedure in the menu “Service tools” -> "Modify Procedure".

2. Export the procedures and display them in the SampleTrack selection box us-
ing the menu “Service tools” -> "Initialize Gilson"

If source TASK procedure is not selected in Registry, then you must:

1. Open selection dialog with menu “Service tools” -> "Set Procedure and Con-
fig File in Registry".

2. Press “Select” button to select procedure in the first line of the dialog.

3. Press “Set Config from Procedure” button to define config (in registry) if differ-
ent.

4. Press “Set” button in the last line to define procedure name (in registry) if dif-
ferent.

5. Press “OK” to exit the dialog.

6. Initialize Gilson with menu “Service tools” -> "Initialize Gilson".

7. Modify procedure with menu “Service tools” -> "Modify Procedure". 

8. Export procedures and show it in selection box of SampleTrack with menu
“Service tools” -> "Initialize Gilson"

Note: New version urine procedures must contain the step “Set Variable:
VAR_CUSTOM_PROC_TYPE= 222 “ to enable the task editor for users!

Setting Procedure / Configuration Dialog 7.2

See "Set Procedure and Config File in Registry" on page 15.

Modifying the Procedure Dialog 7.3

See "Modify Procedure" on page 14.
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8Preparing 1mm 
Samples 8 

Installing the 1mm Gilson Software 8.1

Start the setup procedure and follow the instructions.

Select the default configuration to be active for “1mm Sample preparation” and
press “Change Config Path in all Procedures”, then press OK.

If you intend to run only the 1mm application with this software, check the check-
box: “do not show this dialog again”.

Figure 8.1. Select Default Procedure and Configure 

The installation is now finished.

General System Information 8.2

Z-switch
The needle is mobile inside the needle support and it is protected by a position
sensor in the Z-arm of the Gilson 215 Liquid handler. This sensor is activated if
the needle hits an obstacle in it’s path. If the switch is activated during the 1 mm
filling procedure, the procedure will then skip this sample and put it back into the
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source vial. After a cleaning step, the procedure will continue with the next sam-
ple. An error message will appear in the log file. 

The 1 mm Needle
The 1 mm needle is a flat bottom needle with an outer diameter of 0.5 mm. For
safety reasons the needle is grounded. 

THe 1 mm Rinse Station
The 1 mm rinse station contains a short 1 mm glass tube in order to save solvent
when rinsing the needle from the outside. 

The 1 mm Filling Procedure 8.3

Put the racks on the Gilson wellplate and be sure to label them with the appropri-
ate barcodes. 

1. Turn on the Gilson 215 liquid handler.

2. Start the PrepGilsonST software (if prompted select the 1 mm sample prepara-
tion as the default procedure).

3. Press the top left button to start the automation. The following step will be pro-
cessed: 

- Initialization of the Gilson axis (first time after the robot startup).
- Initialization of the syringe pump (first time after the robot startup).
- The barcodes are read (only on the positions which are defined as “Barcode 
zones” in the tray configuration. For more information on barcode zones and 
tray configurations please consult the general help file).

4. The window in Figure 8.2. will appear with the rack configuration that the bar-
code reader determined in your specific case:
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The 1 mm Filling Procedure
Figure 8.2. Creating Test Order Files 

5. Select a transfer procedure as follows:

Figure 8.3. Select a Transfer Procedure 

6. Select the appropriate solvent that will be used as the system liquid and wash
solvent, as shown in the following figure: 
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Figure 8.4. Select the Appropriate Solvent 

7. In the tray view of the window, select the source tubes where you would like to
transfer the samples from. This can be done by using the “lasso” function
(keep the left mouse button pressed and drag the pointer over the tubes that
you want to select).

Figure 8.5. Select the Source Tubes 

You can zoom into the tray view by clicking the right mouse button and selecting
“scale up”. For each tube an order will appear next to the “create orders” button. 
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8. To create the orders and transfer them into the field “created orders”, press the
“create orders” button.

Figure 8.6. Transferring Orders to the „Created Orders“ Field

Press OK to start the automation.

The 1 mm Filling Parameters 8.4

You can change filling parameters for an existing 1 mm procedure, by using the
“modify procedure” button. The following window will appear: 

Figure 8.7. Modifying Task Procedure Window 

Make sure that the appropriate procedure file is set in the registry by openig the
menu field Service Tools >> Set Procedure/ Config in Registry. Make sure you
press the “set” button at the bottom of the window, as well as the “OK” button for
the changes to take effect.

Change the filling parameters and save the file with a new file name, by clicking
on the “create new procedure “ button.
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Figure 8.8. Saving New Filling Parameters 

Select the new procedure in “Procedure in Procedure Control” in the menu field
Service Tools >> Set Procedure/ Config in Registry (make sure you press the
“set” button at the bottom of the window as well as the “OK” button for the chang-
es to take effect).

Note: Make sure you use different file names so that you don’t overwrite the origi-
nal 1 mm procedure files. 

Troubleshooting 8.5

Orders that failed will be marked with a red exclamation mark (see below). You
can display a textual description by double clicking on the Order file name.
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There is also a main protocol file, that can be viewed by clicking on the but-
ton. 

What if ... Error Message: 
Error Setting Destination Zone + Position in GExec Control

For safety reasons the entire rack configuration will be monitored. For example
you change a single rack with a different barcode ID the original “Source –Desti-
nation Matrix” will no longer match your current configuration. You can add your
current configuration to the “Source – Destination Matrix” by using the menu se-
lection Service Tools >> Delete Map “Source-Destination Matrix” 

What if ... Error Message: 
Automatic switch solvent option is off!

For safety reasons you can change the ValveMate only semiautomatically, so if
you want to use a procedure that does not match the current ValveMate settings,
you must change it by choosing the default solvent as follows: 

1. Go to the configuration view ( ). 

2. Change the default solvent to match the solvent actually used.

To write the new default solvent to the ValveMate click in the menu Clean Proce-
dure >> Set ValveMate default solvent position.

What if a Z-Switch Error Occurs? (needle hits an obstacle)
The order in the “order file name” window will be marked with a red ball. Check
the protocol file, and you will see that the order has been finished successfully.
But this does NOT necessarily mean that the filling was also completed success-
fuly. Scroll through the file and search for “Z-Switch Error”, it will be clearly dis-
played as follows:

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!

!!!!

!!!! WARNING: SAMPLE NOT FILLED

!!!! (Z_SWITCH ERROR)

!!!!

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!

This means that the source sample was not filled in the respective 1 mm tube, but
rather it went back into the source flask. 

What if you don’t get good filling results, or air bubbles or daubed
solutions are in the tube?
Try to optimize the filling parameters. If this doesn’t work, most likely your needle
is broken or clogged up. Take the needle out of the holder and hold it into a waste
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bucket in a way that you can see the solvent coming out. Run the cleaning proce-
dure which you can call through the menu Clean Procedure >> Clean Needle. The
jet of cleaning solvent coming out of the needle should be almost a clear line. If
this isn’t the case, it indicates that there is a problem with the needle. Try to clean
it with an appropriate solvent or polish it very carefully with fine abrasive paper. If
this doesn’t help, exchange the needle completely. 

The 1 mm Gilson Configuration 8.6

Click the “Toggle Config View” button below the menu bar: . 

Click on the part of the image that you want to configure. 

Click in the white area (upper left side, tool-tip: “Base Configuration”) to add or re-
move components (if you do not have a Valvemate, remove it here from the con-
figuration):

Figure 8.9. 1mm Gilson Configuration 

Base Configuration:
If you have a Valvemate activate the corresponding checkbox; if you do not have
a Valvemate, deactivate the respective box. No other GSIOC instruments are
used in the 1 mm procedure. All the respective checkboxes should be turned off in
the configuration even if they are physically present.
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The 1 mm Gilson Configuration
Figure 8.10. 1mm Gilson Base Configuration 

Z-Tower:
Use the following configuration for the new barcode reader (introduced December
2002):

Figure 8.11. 1mm Gilson Z-Tower Configuration 
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Older Barcode Reader Versions
For the older (BEST) barcode reader version use this configuration:

Figure 8.12. 1mm Configuration for Older Barcode Reader Versions #

Click APPLY and OK, to save the configuration file (press the right mouse button
inside the configuration window).

Close the configuration window and press the save button below the menu bar. 

Dilutor:
Start from this configuration and add or remove solvents as described in the gen-
eral software help file.
50 (59) User Guide Version 001



The 1 mm Gilson Configuration
Figure 8.13. Gilson Dilutor Configuration 

Click APPLY and OK, save the configuration file (press the right mouse button in-
side the configuration window).

Close the configuration window and press the save button below the menu bar. 

Valvemate Configuration
If you have a Valvemate for multiple solvent selection, the solvent positions can
be configured here. Add or remove solvents in the Valvemate positions according
to your personal configuration in the laboratory. Solvents can be added from the
“Usable solvents” list by selecting a solvent position and doubleclicking on the de-
sired solvent in the “Usable solvents” list. (Solvents can be added to – or removed
from this list as described in the general software help file.)
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Figure 8.14. Valvemate Configuration 

Configuration without ValueMate 8.7

If you do not have a Valvemate, click in the white area of the configuration window
(upper left side, tool-tip: “Base Configuration”) and remove the Valvemate here
from the configuration.
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9Test/Service Tips 9 

Testing with SampleTrack 9.1

• Start ST Client (password  bsts).

• Start ST Communicator (green circle for polling!).

• ST Client: Select BEST orders from list.

• ST Client: Select create new sample orders from the toolbar (F6). 

- Define matrix ID with the barcode reader by hand.

- Select rack positions with mouse lasso operation on rack view.

- Check Instrument name GILSON.

- Select/Check preparation name in combo-box.

- Select/Check solvent in combo-box.

- Start Generate Orders.

• ST Client: BEST orders list of all orders (filter - All; Matrix ID - with current ma-
trix).

- Select All

- Submit (status changes from created to verified to queued)

Service Information 9.2

1. Default Speed Z Axis

• Can be defined in the registry: Software > Bruker Biospin > Gilson Control >
GExecCtrl > Z Speed

• Values 1 .. 5  (default= 4)
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